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1- OBJETIVOS

Esta sessao de lab visa dar continuidade a familiarizacdo do estudante com a
metodologia de projeto dedicado com aplicativo IC Station da Mentor Graphics e o programa
de simulacao de circuitos ELDO. Especificamente, objetiva:

1) a geracdo do leiaute de um transistor NMOS e a observagdo das regras de projeto
utilizadas, dadas em dimenséao A.

2) Realizar a extragdo do diagrama elétrico deste transistor, realizar a simulagdo e
compreender o modelo de transistor utilizado.

2 - PARTE TEORICA

2.1. O transistor NMOS — funcionalidade

O modelo mais simples do transistor MOS para o programa SPICE, o chamado
NIVEL 1, prevé que o transistor se comporte de acordo com as equacdes abaixo. Este ¢ o
modelo normalmente usado no desenvolvimento de equagdes de corrente, do dreno para a
fonte (Ids), para se determinar as primeiras aproximac¢des de comportamento de circuitos
MOS, baseados nas tensdes entre porta e fonte (Vgs) e entre dreno e fonte (Vds):

1ds=0 , para Vgs < ou = Vtn (chamada de regido de corte)

Ids=p (( Vgs—Vin)Vds—Vds’12) , para Vgs>Vin e Vds<Vgs-Vin (chamada regido
linear)

lds= g( Vgs—Vin) | para Vgs>Vin e Vds> ou = Vgs-Vin (chamada regido de

saturagdo)

w Tox W
com pS=un Cox — ou p=un o2 , onde
L eox L

W e L- largura e o comprimento do transistor NMOS;

un - mobilidade dos elétrons;

Cox- capacitancia por unidade de area da porta do transistor;
Tox- a espessura do 6xido fino, sob o silicio-poli de porta;
eox- constante dielétrica do 6xido de silicio ();

Vin- tensao de limiar de conducao.

Vitn, un e Cox (ou Tox, espessura do 6xido) sdo parametros de cunho tecnolégico que devem
ser fornecidos pelo fabricante em forma de parimetros de modelo de transistor para
simuladores elétricos (SPICE, ELDO, etc.).

O modelo acima apresenta uma precisdo razoavel quando trata-se de transistores de
geometria grande, porém, em escalas submicronicas atuais, ele ndo ¢ adequado. Outros
parametros, referentes a efeitos de segunda ordem como, por exemplo, a velocidade de
saturagiio por campo elétrico, devem ser utilizados. E o caso do modelo NIVEL 53 do ELDO
que adotamos nesta experiéncia.

Uma primeira curva interessante de se estudar ¢ a resultante do experimento
colocando-se uma tensdo baixa em Vds ¢ aumentando gradualmente a tensdo Vgs. Supondo
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que a condicdo seja tal que o transistor venha da regido de corte, quando Vgs<Vtn e va direto
para a regido de linear, e supondo que Vds << Vgs-Vin, a equagdo do transistor nesta regiao
sera: Ids~p Vds(Vgs—Vn) . Veja pela curva abaixo que os valores de Vin e de 3 podem ser
obtidos. Tendo W e L, o valor de ‘un Cox’ também pode ser obtido.

Ids
'y
l Ids Vds << Vgs-Vitn
drain
g M — ik
tan(0) = f*Vds
source
1 > Vgs

Vin

Uma outra curva interessante de se obter com as equagdes anteriores ¢ a que mostra o
transistor conduzindo quando tanto a tensdo Vgs como a Vds variam. Esta curva ¢ mostrada
na figura a seguir (Ids x Vds).

Ids
4 Idsat=B/2 (Vgs-Vtn)2

»Vds

2.2. O Transistor NMOS — construcio

Um desenho do transistor NMOS ¢ mostrado na figura a seguir. Perceba que, além do
transistor em si, € necessario fazer o contato de substrato, no caso para o substrato P, que, na
tecnologia TSMC-035, serd o proprio material da ldmina do chip. Portanto, para um transistor
NMOS nao sera necessario desenhar o Pogo N; este sera necessario apenas quando houver
necessidade de desenhar transistores canal P.

Pocon

Regido
Ativa

. Si-poli .
B

Selecdo p+

Selecdo n+

. Contacto
D Metal 1
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2.3. Extracao de circuitos

2.3.1. Subcircuitos

Os arquivos tipo SPICE apresentam o objeto "subckt” como forma de modular e
hierarquizar a descri¢do de um circuito, facilitando a sua leitura. Funciona como um modulo
de um circuito ou de um programa.

Um subcircuito tem como interface os seus nds. Por exemplo, um diodo tem dois nos e
um circuito somador de um bit pode ter, por exemplo, cinco ndés. A sintaxe para um
subcircuito ¢ mostrada a seguir:

SUBCKT Nome _do_subcircuito nome n6 1 nome n6 2 etc
= componentes internos do subcircuito e suas ligagdes
.ENDS

Os nomes dos nos sdo, neste contexto, denominados locais. Os subcircuitos existem
para serem utilizados em outros circuitos ou subcircuitos. Ao ser incorporado dentro de um
circuito maior, o subcircuito € instanciado da seguinte forma:

X Nome _da_instincia nome n6_ A nome né6_B Nome do_ subcircuito

Neste contexto, os nos, na definicdo da instanciacdo s3o denominados globais. A
ordem dos nos ¢ fundamental, pois a associagdo ¢ feita na sequéncia das listas.

a) Exemplo 1:
Descri¢ao:
. SUBCKT somador carry in carry out 1in 1 in 2 out

=>Descricdo de transistors interconectados

ENDS
No exemplo do somador acima, temos quatro n6s (locais).
Fazemos duas instanciagdes (sdo construidos dois blocos somadores):
X somador 1 ¢ i 1 co 1 in 1 A in 1 B out 1 somador

X somador 2 ¢ 1 2 co 2 in 2 A in 2 B out 2 somador

b) Exemplo 2:
No caso do exemplo 1, se a primeira instanciagao fosse da forma
X somador 1 ¢ i 1 co 1 out 1 in 1 A in 1 B somador

provavelmente teriamos um erro, pois o né global out 1 (saida) seria associado ao
no6 local in_1 (entrada).

2.3.2. Arquivos Extraidos

No fluxo de projeto de circuitos integrados dedicados, apds a edi¢ao do leiaute, é co-
mum realizar-se a extracao do diagrama elétrico do circuito leiautado, para a sua simulagao. A
simulag@o permite: a) verificar a funcionalidade do circuito, detectando eventuais erros inseri-
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dos pelo projetista; b) confirmar as caracteristicas elétricas, uma vez que todos os elementos
parasitarios (decorrentes de interconexao e capacitancias intrinsecas dos transistores) podem
ser extraidos e incorporados a descri¢do do circuito.

No ambiente de projeto do IC Station da Mentor, a ferramenta que realiza a extragdo ¢
o programa CALIBRE. Apoés a extragdo, um conjunto de arquivos descritivos do circuito do
tipo SPICE ¢ gerado. A figura abaixo ilustra o resultado da extracdo de um leiaute especifico
de um transistor. Por depender da forma como o projetista constroi o seu leiaute, ¢ improvavel
que duas extragdes de um mesmo circuito sejam idénticas.

Os arquivos sdo os seguintes:

*.sp.pex- arquivo contendo todos os subcircuitos extraidos, em forma de capacitancias
e resisténcias, correspondentes as interligagdes de metal, silicio-poli, etc. do leiaute (comando
"subckt” do formato SPICE). Cada poligono desenhado para cada camada serd extraido em
forma de componente elétrico. Como ilustrado no exemplo da figura abaixo, cada subcircuito
(em azul) contera nds internos, com os seus nomes locais (como d e s).

*.sp.*.xi- arquivo que contém as interconexdes entre subcircuitos e destes para outros
nos globais do arquivo global de extragao. No exemplo da figura, correspondem as conexdes
contidas na area em vermelho; o subcircuito superior a direita, por exemplo, tem os seus
nomes locais, d e d, conectados pelos nos globais, dd e dd".

*.sp — arquivo do leiaute completo extraido, na forma de um subcircuito global
(principal). Contém componentes como os transistores e insténcias de capacitores e resistores;
também engloba nomes globais dos nés que foram alocados durante a edigdo do leiaute, e que
sao conectados via os componentes do arquivo*®.sp.*.xi . No exemplo da figura, na area verde,
o nome ddd foi definido pelo projetista no seu leiaute e torna-se a um nd global de *.sp.

subckt de cada rede

2424 g8 RC- arquivo *.pex

subckt de toda extragdo,
incluindo os elementos
principais como os
transistores - arquivo *.sp

conecta as redes -
arquivo *.pxi
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3. PARTE EXPERIMENTAL

Os experimentos a seguir referem-se a um transistor a ser construido com a tecnologia
TSMC 0,35 pm.

3.0. Preparo Inicial

Faca os procedimentos de preparagdo ja vistos em experiéncia anterior (no sistema
operacional Linux), em particular, para esta sessao:

— Crie diretério: ~/psi3452/lab2 (para visualizagcdo e acompanhamento, use o navegador
de pastas konqueror)

Observacao: para completar a folha de respostas, vocé deve usar a ferramenta de edigao de
texto, LibreOffice, seguindo o procedimento do documento “Usando os servidores de
aplicativos xserverl e xserver2”.

3.1. Obtencao de parametros do transistor

Abra o arquivo /tools/mgc tree/adk3 1/technology/ic/models/tsmc035.mod com o
Kwrite ou o Kate, e observe os pardmetros fornecidos. Tente comparar alguns dos pardmetros
com o do modelo Nivel 1, visto em teoria (lembre-se que trata-se de um modelo muito mais
moderno e sofisticado com atribui¢do de nivel superior).

= Completar na folha de respostas com as informacaoes solicitadas (item 3.1)

3.2. Definicio das dimensoes do transistor canal N.

As dimensdes serdo definidas de acordo com o nimero USP do aluno, da seguinte
forma:

Largura do transistor (Wn em A) € o penultimo algarismo do seu nimero USP. Se for
< 5, some o valor 5 a ele.

Comprimento do transistor (Ln) ¢ formado com o ultimo algarismo do seu ntimero
USP. Considere o algarismo como £, entdo a dimensao ¢ (k mod 4). Caso o resultante for < 2,
some o valor 2 aele.

Exemplo 1: #USP 3164124 leva a W, =7A (ou seja, 2+5 ) e L,=2A (pois k=0)
Exemplo 2: #USP 3164167 levaa W, =6Ae L,=3A.

Observaciao: Como usaremos a tecnologia 0,35um, no exemplo acima, temos que A=0,2um
(dentro da opgao MOSIS SCMOS). Logo, o transistor tera:

Exemplo 1: W,=7A=14um e L,=2A=0.4um.
Exemplo 2: W, =6A=12um e L,=3A=0,6um.

= Completar a folha de respostas (item 3.2)
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3.3. Levantamento de curva teorica Ids x (Vgs, Vds) com o modelo simplificado

Vamos agora calcular valores de corrente Ids x (Vgs, Vds) com as equacdes
simplificadas dadas na parte de teoria.

Obs. Os parametros que vocé€ separou na secdo 3.1 sdo considerados basicos, isto €, nas
equagOes bastante complexas, utilizadas no simulador de circuitos, sofrem uma série de
correcdes por parte de outros pardmetros do modelo SPICE. As corregdes atuam, quase na sua
totalidade, no sentido de diminuir o valor da corrente Ids. Desta forma, calcular a corrente
com as equagdes simplificadas dadas na se¢c@o de teoria e com os parametros basicos levara
provavelmente a uma superestimaciio do valor de Ids.

Para facilitar a obtencdo da curva teorica simplificada do transistor, uma planilha sera
fornecida. Copie o arquivo IdsVds.ods que estd em /home/disc/psi3452/lab2 para a sua
recém-criada pasta ~Zab2. No konqueror, clique duas vezes sobre o icone IdsVds.ods e o
aplicativo de planilha do LibreOffice se abrira.

Na parte superior da planilha, substitua os valores arbitrarios pelos que vocé encontrou
nas secoes 3.1 e 3.2. Atente para as unidades dos parametros.

Observacio: A constante dielétrica do 6xido €ox ja ¢ fornecida na planilha.

A seguir, para cada um dos valores de Vgs=2V e Vgs=3V, calcule os valores de Vdsat
e inclua-os na planilha. Como um exemplo, os valores calculados de Vdsat poderiam ser (caso
Vt=0,68V):

Vgs(V) Vgs(V)
3 2
Vdsat(V) 2,32 1,32

Com isso, as curvas Ids x (Vgs=2V, Vds) e Ids x (Vgs=3V, Vds) poderdo ser automaticamente
geradas. A planilha ja prepara uma sequéncia de valores de Vds espacadas de 0,2V. Para ter o
numero certo de pontos faca o seguinte (veja a ilustragdo abaixo):

- selecione as células inferiores e coloque o cursor no canto inferior direito da célula
da direita (deve aparecer uma cruzeta) e arraste pra baixo;

- faca de tal forma que tenha pelo menos cinco pontos acima da tensao de saturagio

para Vgs=3V

Vds(V) Ids(mA) (Vgs=3V) [lds(mA) (Vgs=2V)
0 0 0

0,2 0,089920064 0,05167116

0,4 0,172190347 0,095692539

0,6 0,246810849 0,132064137

0,8 0,313781571 0,160785954

1 0,373102511 0,181857991

1,2 0,424773671 0,195280246

4

= Siga as instrucdes da folha de respostas (item 3.3)
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3.4. Desenhando o transistor no IC Station

No Linux:
- Abra um terminal e va para este diretorio ~/psi3452/lab2

- Tecle source /home/disc/psi3452/perfil mgcl para ativar as variaveis do ambiente.
Lembre-se sempre de realizar esta tarefa quando abrir um terminal- este alerta ndo sera
mais repetido futuramente...

- Tecle adk_ic & para disparar a ferramenta de edi¢ao IC Station.

- Abra uma nova célula (utilizando o comando New e preenchendo, em seguida, a janela
que se abre). Neste manual, adotaremos NMOS como nome da célula. Utilize o
mesmo processo € as mesmas regras adotadas na sessao de lab 1.

Durante a edicao do seu leiaute vocé deverd obedecer as regras do processo CMOS da
TSMCO035. Algumas regras importantes foram relacionadas indicadas no anexo 1 da apostila
do labl. Utilize-as como referéncia.

ATENCAO: o programa DRC devera ser usado durante a edigdo para verificar se nenhuma
regra de projeto esta sendo violada.

No desenho de um transistor, as mascaras (aqui chamadas de camadas) devem ser inseridas na
sequéncia que tem sido apresentada nas aulas de teoria:

+» Nwell (apenas para transistor PMOS) (utilizada na préxima sessao de lab)

s Active

s Poly

% N_Plus_Select

s P_Plus_Select (apenas para transistor PMOS) (utilizada na préxima sessdo de lab)
% Contact_to_Poly

¢ Contact_to Active

s Metal 1

¢ Via (utilizada na préoxima sessao de lab)

% Metal2 (utilizada na proxima sessao de lab)

Observag¢ido: Como ja visto na teoria, a camada P_ Plus_Select pode ser usada para definir a
regido de contato de substrato. Entretanto, na nossa sessdao com o IC Station, usaremos uma
outra forma para isto, como podera ser vista mais adiante.

Os tamanhos das camadas sdo computadas da seguinte forma (medidas em A):

— A camada Active deve ter a dimensdo Wn X (2 * DRC6 1 + 2 * DRC6 2 + 2 *
DRC6 4 + Ln) => calcule o seu valor

— A camada Poly deve estar centralizada em relagdo a camada Active e ter Ln X (Wn +2
* DRC3_3) => calcule o seu valor

= Completar a folha de respostas (item 3.4.A)
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A figura resultante, exceto pela largura e comprimento do canal, deve ser similar a
mostrada a seguir. Use-a como referéncia para o seu desenho no IC Station.

- Posicione as camadas de Active e Poly, procurando centraliza-los (em 0,0).

Observacio: Nao se esqueca de gravar o seu projeto a cada mudancga!! A ocorréncia de al-
gum pane no software e a perda de edi¢des realizadas e nao gravadas € um evento extrema-
mente frustrante e desagradavel !!!

Observacio 2: Apds a gravagio, o seu desenho NAO estard mais reservado para edi¢do. Para
continuar editando o seu trabalho, reserve o seu desenho novamente para edicdo, como instru-
ido na sessdo de lab 1.

— A camada N Plus deve conter a camada Active, com um avango extra de 2A (DRC4 2)
em todos os lados.

— A camada Contact (dos contatos de fonte e dreno) devem ter exatamente 2A x 2A
(DRC6 _1) e devem estar distantes de 24 (DRC6_4) da camada Poly e estar contidos na
camada Active, com, no minimo, 1,54 (DRC6 2) de cada lado.

— A mascara Metall deve cobrir e conter os contatos, com um avango extra de, pelo
menos, 1A (DRC7_3) de cada lado.

— Se ndo o fez ainda, grave o seu desenho.

Ative agora a verificagdo do leiaute (DRC) (siga as instrucdes da sessdo de lab. 1) para
observar se algum erro foi cometido. Se vocé cometeu algum erro que viole as regras acima
mencionadas, corrija-as e reative o seu DRC até que ndo ocorram mais indicagdes de erros.

Atencao: haverd um Uinico erro que vocé ndo sera capaz de corrigir neste momento. Qual ¢
ele? Pense o porqué.

A proxima agdo ¢ gravar o desenho do leiaute no formato TIFF (como realizado na
sessao do labl). Ela deve ter a forma similar ao da figura abaixo, porém com as medidas deri-
vadas do numero USP. Verifique que ela apresente as dimensdes corretas.

= Siga as instrucdes da folha de respostas (item 3.4.B)

PS13452 - 2017



3.5. Adicionando o contato de substrato

O substrato p precisa ser polarizado e um contato deve ser criado para este fim. Para
implementar o contato de substrato sera utilizada uma célula da biblioteca padrao que
acompanha o pacote ADK.

Na pasta /tools/mgc_tree/adk3 1/technology/ic/process/tmsc035 estio armazenados
diversos blocos 16gicos digitais (inversores, nands, nors, etc...). Com o navegador de pastas,
verifique o seu contetido.

Na  pasta  /tools/mgc_tree/adk3_1/technology/ic/process/tmsc035_via  estdo
armazenadas células de contato de substrato possiveis de serem usadas nesta tecnologia. Com
o navegador de pastas, verifique o seu conteudo.

Usaremos a célula ‘pwell contact’ que se encontra nesta segunda pasta. Para isto, no
IC Station, acione na barra de menu (na parte superior da tela) o comando

— Add—Instance

e procure (usando o browser) a c€lula acima. Em seguida, na tela de desenho, acrescente esta
célula encostando-a no transistor ja desenhado pela parte inferior. Use a tecla Esc (do teclado)
para sair deste modo.

Para ver todas as camadas desenhadas, inclusive as das células:
— Selecione todo o leiaute com: Select—Select— All

— Visualize com: View—Peek—Peek e na caixa selecione o Number of Level 99 e tecle
OK.

— Desselecione todo o leiaute (F2 com o ponteiro do mouse sobre a grade, mas fora do
leiaute).
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— Se o leiaute ndo couber na tela use a opgao View -> All.

= Completar a folha de respostas (item 3.5)

3.6. Insercao de portos (port) lisados a0 METAL1 e seus rotulos (labels)

Para definir os portos do circuito e associad-los a rotulos (nomes dos nds), algumas ca-
madas deverao ser adicionadas, como ilustrado na figura a seguir.

[3 1€ 0: exp2 > exp2 () - IC Station Layout Editor _— - < a %
MGC File Edit Add Select Copext Conneciivity Report View Tools Windows Setup Help ADK R
) (e = it ! | Il &8 Wit < s = 111
BEHG - aE| THs T ®he T Teor B
f garmey | |||context: exp2(GE-R 0) Process: sme035(A) Cursor 21.000 8500 Layer ISel O Hatkeys: on
H - @ » | & ubaslect.| B i H Dynam: Status:
=il Cbject Editor v R X Layer Paletie v & Xl |CPalettes v EX
- = IC 0: exp2 » exp2 (i) =
K ea BX| BER =i ¥ t5mc03s SR o= Easy Edit |
B & b —_—
) 4 . . . . S I . . s WETAL e i
% Propery | Value 4| . DRENG 'ﬁ Edit
4 S - — Expent Edit
Layer Prav SMF &
B =1 GBC Edit
WETAL1 PORT
:.' VIA DLA Layout
— = METAL DLA Device
0 CONTACT_TO_.. —
CONTACT_TO_..
e} POLY IC Session
= | N_PLUS_SELECT
L ; v | P_PLUS SELECT [Crules
= El I | acTIvE - i Instant DRG
IR Atrbute | Value E N_WELL ] Short Checker
L} =
2 Gtrace (D)
-
el 1Gtracs (M)
[_j | Veritdp (DAC)
i N > : Verlidp (LVS)
T FONTE Cassemble
& Plan & Place
it - Foute
v
e ADK Edit
e Lol v

Hote: Working dictory s=t o "$MGC_WD" -
@ Hote: Ruks fik boaded. =
Hote: Release Szlect button to complets GROW Ll

3.6.1. METAL 1 para dreno. fonte e substrato

Primeiramente, linhas de METAL 1 serdo acrescentadas para conectar aos contatos de
fonte, dreno e substrato. Veja qual ¢ a largura minima do METAL 1 de acordo com as regras
de projeto (Apéndice 1 da apostila do lab 1)

Conecte a fonte do NMOS com o contato de substrato usando a camada METALI,
como na figura a seguir (adotaremos esta condicdo em que ambos estdo em curto e serdo pola-
rizados em GND). Ha diversas formas para fazer tal ligacdo. Vocé€ pode desenhar um retangu-
lo de METAL1 encostando-o no quadrado de METAL1 j& desenhado e cobrindo o contato de
substrato. Outra forma (mais elegante) ¢ aumentar o tamanho do quadrado de METAL1 ja de-
senhado sobre o contato da fonte de forma a envolver o contato de substrato (usando o co-
mando Stretch). Fica ao critério do aluno como realizar tal passo.

Desenhe mais uma tira vertical de Metall cobrindo o contato de dreno conforme mos-
trado na figura abaixo.

Desenhe mais uma tira horizontal de Metall cobrindo o contato de fonte conforme
mostrado na figura abaixo.
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3.6.2. METAL 1 e contato de POLY

Agora, o aluno deverd acrescentar um contato que conecte a camada de METAL 1 ao
de POLY, como indicado na figura.

Primeiramente, acrescente um quadrado de POLY de dimensao 5SAxSA
(DRC5_14+2*DRCS5_2) separado em 2A do canal do transistor (DRC3 5 diz que separagdo
pode ser 1A, mas para respeitar a regra de espagamento entre metais, use 2A). Cuide para que

este quadrado de POLY esteja ligado a porta do transistor (uma ligagdo feita com o proprio
POLY).

A seguir, acrescente uma camada de contato entre a camada de Metal 1 e o de POLY,
usando o comando ‘Easy Edit -> Shape’ e selecionando a camada ‘Contact_to_Poly’. Gere-

o com a dimensdo 2Ax2A (DRCS5 1) e centralize-o no quadrado de POLY desenhado no passo
anterior.

Finalmente, cubra o contato com um retingulo de METAL1 de dimensao 4Ax4A4
(DRC5_142 DRC7 _3).

Para finalizar, faca uma extensao de METALI como mostra a figura.

3.6.3. Portos e Rotulos- definindo nos elétricos do circuito

Adicione texto para cada terminal (PORTA, FONTE, DRENO, por exemplo) ligado as
tiras de METALI que vocé acabou de desenhar. Para isto, a camada METAL1.PORT sera
usada. Cada camada de porto correspondera a um no elétrico (porto) da célula que sera usado
como terminal de comunicag¢do desta célula com alguma outra célula irma, ou a sua célula
mae (de maior hierarquia).

Atencdo: A camada METAL1.PORT NAOQ corresponde a uma méscara, sendo usada apenas
para fixar os portos da célula.

Para adicionar as portas, use o comando ‘Add—Text’.

Observe se em ‘Object Editor’ o Layer Name seja ‘METAL1.PORT"’. Se ndo estiver,
isto pode ser feito tanto usando a Layer Palette,como escrevendo diretamente.

Também, no ‘Object Editor’ coloque o nome do porto a ser usado (DRENO, por
exemplo) no campo Value.

Para que este valor (nome) seja efetivado pelo ‘Object Editor’ tecle RETURN

Em seguida, posicione o cursor (grudado no cursor esta o nome que vocé usou) sobre
o METAL1 que servira de porto e clique o botdo da esquerda do mouse para implementar.

Repita o procedimento para, uma para a fonte e porta. A figura resultante deve ser si-
milar com a mostrada acima.

Nao se esqueca de gravar a sua célula e depois volte a habilita-la para edigao.

Faga a verificagdo do leiaute (DRC). Se houver erros, elimine-os até que nenhum erro
aparega.

Grave o leiaute (que deve ser parecida com a figura a seguir) em formato TIFF.
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3.7. Extracao do diagrama elétrico

Como relatado na se¢do de teoria, pode-se agora realizar a extragdo do diagrama elétri-
co para sua posterior simulagdo. A extracdo ¢ feita com o programa CALIBRE. Para isto siga
0s seguintes passos:

— Acione Tools—>Calibre—Run PEX.

— Na janela que aparece apos a licenca ser adquirida, preencha o campo Load Runset
com o arquivo /tools/mgc_tree/adk3 1/technology/calibre/pex.tsmc035.runset, que
contém algumas das varidveis usadas na extragao)

— Confirme clicando em OK

— Clique em Run Pex e aguarde.
Trés arquivos sdo gerados: ‘NMOS.sp’, ‘NMOS.sp.pex’ e ‘NMOS.sp.NMOS.pxi’. Ob-
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serve que o nome depende do nome da célula que originou os arquivos, no caso, NMOS (caso
vocé tenha mantido este nome). Reveja a secdo 2.3 para entender qual € o contetido destes ar-
quivos.

O ELDO ¢ o simulador elétrico da Mentor Graphics (muito semelhante ao SPICE).

O arquivo NMOS.sp (criado anteriormente) corresponde ao seu leiaute, porém estd em
forma de subcircuito e precisa ser instanciado em algum arquivo topo. Use o programa Kwri-
te para criar um arquivo semelhante ao do exemplo mostrado a seguir. Grave o arquivo com
um nome qualquer a sua escolha. No exemplo abaixo o arquivo foi denominado de
exp2ldsVds.sp.

Observagdo: O arquivo exemplo exp2ldsVds.sp a seguir encontra-se na pasta
/home/disc/psi3452/l1ab2. Se quiser, copie este arquivo para a sua pasta € apenas edite as alte-
ragdes que forem necessarias.

Atencao: No exemplo, o xEXP2 ¢ o nome de uma instancia do sub-circuito NMOS
que estd descrito em NMOS.sp. A ordem em que os terminais globais sdo descritos deve ser a
mesma do subcircuito NMOS em NMOS.sp. O extrator pode designar os terminais em dife-
rentes sequéncias, dependendo da posicdo geométrica dos mesmos no leiaute especifico do
aluno.

Observacio 1: A primeira linha do arquivo ¢ sempre vista pelo ELDO como comentério.

Observaciao 2: A descricdo do modelo de transistor ¢ incluida automaticamente no seu arqui-
vo topo de simulacdo pelo comando ‘.include /tools/mgc tree/adk3 1/technology/ic/
models/tsmc035.mod’ (reveja o item 3.1).

ARQUIVO EXEMPLO (exp2ldsVds.sp)

Simulacao do transistor NMOS no ELDO para determinar a curva Ids x Vds
.include "NMOS.sp"

.include /tools/mgc_tree/adk3 1/technology/ic/models/tsmc035.mod

xEXP2 porta dreno 0 NMOS

vdreno dreno 0 3.3

vporta porta 0 3.3

.dc vdreno 0 3.3 0.1 vporta 0 3.3 0.5

.plot dc i(vdreno)

.end

Atengdo: o manual do ELDO encontra-se em /tools/mgc_tree/ams/docs/pdfdocs/. Verifique-
0, procurando, por exemplo, os capitulos de fontes independentes, elementos passivos, sub-
circuitos ¢ decri¢ao do mosfet. Encontrou-os?

o
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Outros elementos a serem adicionados no arquivo de simulagdo sdo as fontes de tensao
ou corrente, além da defini¢dao do tipo de andlise sera encaminhada na simulagdo. O arquivo
exp2ldsVds.sp estd preparado para uma simulagdo IdsXVds (para diferentes valores de Vgs).
Tenha certeza que consegue associar os comandos de tensdo com a simulacao desejada.

Para rodar o ELDO vocé deve acessar a janela e pasta de onde rodou o script
‘perfil_mgcl’. Para disparar o simulador tecle:

— eldo exp2ldsVds.sp (a sintaxe do comando ¢ eldo nome do seu arquivo de si-
mulagdo).

Corrija eventuais erros até que ndo haja problemas tanto de compilacdo como de exe-
cucgao.

O programa ezwave ¢ usado para visualizar graficos. Para rodar o ezwave tecle:

— ezwave  exp2ldsVds.wdb (a  sintaxe do comando ¢é  ezwave
nome_escolhido por vocé.wdb — este arquivo ¢ gerado pelo ELDO).

No ezwave, abra a pasta 'exp2ldsVds’ na janela da esquerda e arraste o arquivo 'DC'
para a janela a direita.

A curva resultante deve ser parecida com a mostrada na proxima figura.

Observacio: A corrente mostrada € negativa. Vocé esperava isto para um transistor canal N?

Para obter a curva em formato portavel para outros aplicativos clique:
— File»Print
— Na janela que aparece clique em File e digite um nome(IdsVds, por exemplo).

— Tecle OK.

¥ EZwave 2010.2 Production e v oA x
File Edit Yiew Format Tools Cursor Window : Help
EFH S LR X |0 =B Fles mBMEGE &S B HWBETH

Waveform List x
[

iContains 7

[Currently Open Databases |

= i exp2ldsVds  C /hone,
&bc

Contains @
il hame

oC

¥ I(/DRENO)

Tree List. ] | [311em

Em sua pasta de trabalho aparecera o arquivo IdsVds.ps (formato post-script). Para
converter este arquivo, use o programa GIMP.

Dispare o GIMP:
— gimp
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Abra o arquivo com o comando File—>Open e na janela que aparece selecione o arqui-
vo IdsVds.ps confirmando com OK.

Aparecerd uma nova janela perguntando se vocé quer importar este arquivo; responda
Importar. Escolha o nome com a extensdo '.jpg', ou seja, acione o comando File>SaveAs, ¢
escolha o nome IdsVds.jpg. Grave o arquivo, com a resolucdo proposta de 85%, e o arquivo
exportado para jpeg aparecera no diretorio.

Com o auxilio do arquivo Excel da secdo 3.3 e da curva gerada, deve-se comparar os
valores obtidos pela simulacdo com o do modelo simplificado. Para cada uma das tensdes
Vss=2.0V e =3.0V, escolha os mesmos dois pontos de Vds definidos na Sec¢ao 3.3.

Usando os valores simulados como referéncia, por serem mais precisas, calcule os er-
ros observados:

Erro (%) = 100* (Ids_idealizado — Ids_simulado)/ Ids_simulado

3.9. Simulacio de Ids x Vgs usando 0 ELDO e visualizacio usando 0o EZWAVE

Um novo arquivo deve ser criado para a simula¢do IdsXVgs (parametrizado por valores
de Vds). Crie um novo arquivo de simulagdo cujo nome, por exemplo, sera exp2IdsVgs.sp
(vocé pode usar outro nome, se desejar). A forma mais simples de criar este arquivo € criar
uma cépia do seu arquivo anterior ¢ modifica-lo, como mostrado abaixo (ndo se esquega de
modificar a primeira linha, de comentario).

ARQUIVO EXEMPLO (exp2IdsVgs.sp)

Simulacao no eldo do Transistor Ids x Vgs nome exp2ldsVgs.sp
.include "NMOS.sp"

.include /tools/mgc_tree/adk3 1/technology/ic/models/tsmc035.mod
xEXP2 porta dreno 0 NMOS

vdreno dreno 0 0.1

vporta porta () 3.3

.dcvporta 01 0.01

plot dc i(vdreno)

.end

Tenha certeza que consegue associar os comandos de tensdo no arquivo exp2ldsVgs.sp
com a simulagdo desejada.

Nao se esqueca que para rodar o ELDO, vocé deve utilizar a janela e diretdrio onde ro-
dou o ‘perfil mgcl’.

Tecle:

— eldo exp2IdsVgs.sp.
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Verifique se ndo ocorreram erros na execucao (corrija-os se houver).
Rode o ezwave:
— ezwave exp2ldsVgs.wdb

No ezwave, abra na janela a esquerda a pasta 'exp2ldsVgs' e arraste o arquivo 'DC'
para a janela a direita.

A figura resultante deve ser parecida com a seguinte. Repetindo o procedimento anterior, ou
seja, gerando o “.ps’ e depois o ‘.jpg’, grave a curva.

n EZwave 2010.2 Production - v A x
File Edit ¥iew Format Tools Cursor Window
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777 E—

[ =)
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